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September 14 & 28 

Hello Everyone ! 

 

Have you missed my President’s Messages 
these last two months ?  Maybe not too 
much … lol.    Well, I am finally back in 
enough time to function again.  (At first it 

always seems like you arrived from a different planet with 
that jetlag … lol). 

Thank you, Connie, for taking over for me while I was 
gone.  It is so great to know that someone as reliable and 
efficient as Connie is here to back me up whenever I need 
her. 

Are you all excited about our Club Project, the new inter-
active Club website ?  We have an opportunity to share 
our knowledge, experiences, hobbies, recipes, whatever, 
and get to know one another better.  Also, we’ll learn how 
something like that is done.  Sounds good to me !  Thank 
you, Bill, for all your hard work on this project ! 

I have not forgotten about the Calendars I had wanted us 
to have an opportunity to make. 

These can be the big wall calendars with pictures, that I 
have always spent a fortune on when I sent them as 

Prisoner of War/Missing in Action 

Remembrance Day, September 16th 
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Christmas presents to family.  Bill has some software he wants to share with us that will make 
those calendars.  That will be in October, in plenty of time for Christmas. 

Speaking of Christmas, our holiday potluck will be here before we know it, and the Board 
thought it was a good idea to have a Silent Auction again.  I will be here to conduct it.  I al-
ways have a lot of fun doing it, and it does make some money for the Club and “relieves” us 
of our “treasures.”  So, start saving and setting aside your items now. But don’t bring them un-
til the day of the auction.  Barbara Denny has volunteered to be our Holiday Potluck Chair 
again, and she will take any help you offer, I am sure.  

Don’t forget to read the Newsletter. It has such excellent information and keeps us abreast of 
what is happening and what is planned for our Club.  There are two upcoming classes, Inter-
net and E-mail, and Digital Media, that could be very interesting for some of us to take, or 
someone you know.  Remember,  students don’t have to be GSCC Members (But we sure like 
them to join later…. Ha, ha.). 

Thank you for all the refreshments to all of you who brought them recently.  They are such a 
nice picker-upper at breaks.  And – do stay for the last half of the meeting. That is your oppor-
tunity to ask questions and learn from others’  computer problems. 

And last, but not least,  consider taking an active part in your Club Leadership and take an of-
fice next year.  It is not hard, and everyone should do their part in making this Club run. We 
current Board Members are seriously looking for replacements ! 

 

Take care, 

See you soon, 

 

Annemarie 

Confucious say 

If 4 out of 5 people suffer from 
honorable diarrhea, does that 

mean that one enjoys it? 
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Meeting Minutes 
August 10, 2011 

President Annemarie Hunt opened the meeting at 1:00 pm welcoming members and 
guest, Barbara Klein. She thanked Vice-President Connie Lang for presiding 

while she was on vacation.   

Announcements:  

1) Membership now stands at 129 with several new members including: Jo Bader, Helen 
Deamos, Rick Edwards, Bill Higley,  Mary Ann Kemnitzer, Francisco Lobaco, Sandee 
Rose, Sharon Steinberg, and Adriaan Verhagen.  

2) Program Chair, Jim Glass announced the November Program would be about Opera 
Web Browser software.  August 24 Program will be presented by representatives from the 
Glendora Public Library.  

Bill Belcher Education Chair presented today’s program, an overview of the Group Project, 
Building a Website.  Bill has developed the preliminary work including the Banner, Home 
Page and a proposed list of pages for the Club’s New Website featuring Interests and Activi-
ties of GSCC Members.  Members are asked to sign up for a page or pages that are of specific 
interest to them; develop and contribute specific text and graphics in a word processing pro-
gram submitting their pages to an email address TBA at a later date.  The content will then be 
programmed by the Project Committee (Bill, Jim, Sharon & Glen) using Dreamweaver 
Software with HTML and CSS programming vs. templates. 

Education—Bill Belcher and Ell Fullmer answered questions including:  1) I Pad tutorial--
Google Leo Leporte webpage & podcasts; 2) Excel Spreadsheets; 3) Saving videos to the hard 
drive or other devices; 4) SSL Certificates - Secure Sockets Layer. 

Fall Class will be Moving from Analog to Digital Media. 

President Hunt thanked Sandee Rose and Glen Moore for cookies today.  Ernie Gagne and 
Leroy Overstreet will bring cookies for the August 24th meeting. 

Other – The 50/50 drawing was won by Anne Stutsman.   

Next meeting – Wednesday August 24.  President Hunt distributed mini flashlight key rings 
as her gift to all members.Adjournment: 3:00 pm  

Submitted by:        Approved By: 

Secretary Ruthann Mayrose     President Annemarie Hunt 
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Meeting Minutes 
August 24, 2011 

President Annemarie Hunt opened the meeting at 1:00 pm welcoming new members Rick 
Edwards, Mary Ann Kemnitzer, and Barbara Klein.  Thirty-seven members in attendance to-
day. 

President Hunt made the following Announcements:  

1) There are a few “Free” items on the back counter including a dot matrix printer & pa-
per; the free items are a result of an inventory and cleanout of the closet.  Other items 
will be saved for the Holiday Party Auction. 

2) There are also brochures for the Tri Community Photography Program available. 
3) The Group Project (website) submissions should be approximately a paragraph plus a 

photograph. 
4) Connie is looking for “old” digital cameras for demo purposes at her class. 
5) Barbara Denny will chair the Holiday Party. 
6) There is a need to fill 2012 positions (Elected Board & Committee Chairs).  Submit 

names for nominations. 
 

Program Chair, Jim Glass introduced Gaetano Abbondanza of the Glendora Public Li-
brary who gave an overview of the Electronic Resources available at the library.  Starting 
with the Library Home Page www.Glendoralibrary.org, there are links to Audio Books for 
download, Databases, Newspapers, and more.  Software is available to download–Overdrive 
Audio books can be used on PC's, laptops and supported MP3 devices or copied to a CD. 
Overdrive eBooks can be transferred to your ereader.  

Education—Bill Belcher and Ell Fullmer answered questions including:   
1) How to transfer data from old floppies. 

2) Compatibility issues with AVG and other software. 

3) Registry Cleanup—“…be careful about deleting!” 

4) Question about multiple servers (5). 

 

Fall Classes: Connie – Internet & Email;   Bill – Mixed Media, Analog to Digital, Calendar 
Demo (future meeting program).  Submit Group Project data to GSCCTeacher@gmail.com. 
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President Hunt thanked Ernie Gagne and Leroy Overstreet for cookies today. Bill Hart 
and Frank Duran will bring cookies for the September 14th meeting. 

Other – The 50/50 drawing was won by Barbara Klein.   
Next meeting – Wednesday September 14.   

 

Meeting Adjourned: 3:00 pm  

Submitted by:        Approved By:  

Secretary Ruthann Mayrose     President Annemarie Hunt 

 

September and October – Email and the Internet 

Do you want to surf the internet safely? Find what you are searching for quickly and effi-
ciently? 

Want to print just part of a web page? Do some shopping? Get free stuff? Ever wonder why 

everyone is fussing about YouTube and Facebook? Find old friends? Make new ones? Make 

your email behave the way you think it should? Reduce the amount of spam in your inbox?  

Send and receive attachments without a hassle? Send email to a group of people all at once?  

Then this is the 8 week class for you. 

When: Thursdays, September 8 through October 27 – 1:00 to 
3:00 PM 

Class fee: $40.00 paid at least one week prior to start of class. 

Limited to 12 students 
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September and October – Moving from Analog to Digital Media 

Do you have boxes of pictures and slides and drawers of old video tapes that you wish you 
could convert to digital pictures and videos? How about all those old vinyls and cassette 
tapes?  

Would you like to convert them to CDs and MP3s? This 7 week class is designed to teach 
you the basic hardware and software techniques to get you started on that project.  

The class will cover the techniques of scanning still media, conversion of analog audio and 
video to digital as well as some basic video editing.  

There is an all day workshop scheduled to allow students to use the computer club’s limited 
assets to convert their own projects. 

When: Tuesdays, September 6 through October 18 – 1:00 to 
3:00 PM 

Saturday, October 1 – 9:00 to 4:00 PM 

Class fee: $40.00 paid at least one week prior to start of class. 

Limited to 12 students 

Jumping to Conclusions 
  
Feeling it was time for a shakeup, XYZ Corporation hired a new CEO. The new boss was determined to rid 
the company of all slackers.  
 
On a tour of the facilities, the CEO noticed a guy leaning against a wall. The room was full of workers and 
he wanted to let them know that he meant business. He asked the guy, "How much money do you make a 
week?"  
 
A little surprised, the young man looked at him and said, "I make $400 a week. Why?"  
 
The CEO said, "Wait right here." He walked back to his office, came back in two minutes, and handed the 
guy $1,600 in cash and said, "Here's four weeks' pay. Now GET OUT and don't come back."  
 
Feeling pretty good about himself, the CEO looked around the room and asked, "Does any-
one want to tell me what that goof-ball did here?"  
 
From across the room a voice said, "Pizza delivery guy from Domino's." 

(Submitted by club member Glen Moore) 
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(Excel) 

Understanding Manual Calculation 
 

When you change a value in any cell of a worksheet, Excel automatically recalculates all 
the other formulas within the worksheet. This means that Excel is always up to date, based 
on any changes you may have performed. 

If you have an absolutely huge worksheet or a terribly slow computer (or both), then doing 
a calculation after every change can get very tedious. In these situations, you can actually 
spend more time waiting on Excel to finish calculating than you do on entering informa-
tion. 

The answer to this problem is to configure Excel so that all calculations are done manually. 
This is easy to do by following these steps: 

1. Display the Excel Options dialog box. (In Excel 2007 click the Office button and 
then click Excel Options. In Excel 2010 display the File tab of the ribbon and then 
click Options.) 

2. Click the Formulas area at the left of the dialog box. 
                                                                                            (Continued on page 8)                           

Thanks for bringing cookies 
to the July 27th Meeting: 

Leroy Overstreet 
Ernie Gagne 
Dan Leddy 

Thanks for bringing cookies to 
the August 10th Meeting: 

Glen Moore 

Sandee Rose 

The Computer Guys, Bill Belcher & Ell Fullmer, will be meeting on the  

SECOND Thursday of the month:  

September 8th 

9:00 a.m. to 12 noon — Second Floor — La Fetra Center 
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(Excel) 

 
The Formulas area of the Excel Options dialog box. 

3. In the Calculation Options section of the dialog box, make sure the Manual radio 
button is selected. 

4. Click on OK. 
Now, Excel does not calculate your worksheet automatically. Instead, you must press F9 
whenever you want to update the results displayed within your worksheet. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thou-
sands of free Microsoft Excel tips can be found online at http://excel.tips.net. 
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Word 
Repeating Rows for a Table Footer 
When working with longer tables in a document, you may wonder if there were a way to re-
peat rows at the bottom of a table that spans multiple pages, the same way you can repeat 
rows at the top of a multi-page table. The short answer is that Word doesn't provide such a 
capability. If you are willing to experiment a bit, you can try to come up with a workaround 
that may do the trick for you. 

What you want to do is create a document section that contains just your table, and then use 
the page footers to contain the rows you want repeated from the table. Follow these general 
steps: 

1. Just before the start of your table, insert a continuous section break. 
2. Do the same thing just after the end of your table. 
3. Select the rows you want repeated at the bottom of the table and copy them to the 

Clipboard. 
4. Choose View | Header and Footer to display the headers and footers of the document. 

(If you are using Word 2007 or Word 2010 display the Insert tab of the ribbon, click 
Footer in the Header & Footer group, and then click Edit Footer.) 

5. Switch to the footer. (You don’t need to do this in Word 2007 and Word 2010, since 
you are already editing the footer after step 4.) 

6. Make sure that the Link to Previous option is turned off for the footer. 
7. Select anything that already exists in the footer. 
8. Press CTRL+V to paste the copied rows into the footer. 
9. Use the controls on the Header and Footer toolbar or, in Word 2007 and Word 2010, 

the Design tab of the ribbon to advance to the next section. (You should be looking at 
the footer for the section following the section in which the table resides.) 

10. Turn off the Link to Previous option for this footer. 
11. Delete the table row from this section's footer. 
12. Close the Header and Footer toolbar (click Close) or, in Word 2007 and Word 2010, 

click Close Header and Footer in the Close group. 
You are now ready to place the final touches on your workaround. Position the insertion 
point somewhere in your table, then use the various tabs in the Page Setup dialog box to ad-
just the relationship between your table and the footer. You'll need to play with the settings 
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Word 
on both the Margins and Layout tabs to position the rows in the page footer, and you'll want 
to make sure that the Apply To drop-down list applies the changes to only the current section 
(the one with the table in it). 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thou-
sands of free Microsoft Word tips can be found online at http://word.tips.net. 
 

 Tracking the latest information on anything 

By John Weigle, Editor, Channel Islands PCUG, CA 

August 2011 issue, The Outer Edge 

www.cipcug.org 

jweigle (at) vcnet.com  

If you want to keep track of the latest news and Web postings on specific subjects, 
give Google Alerts a try.  

I’ve been using the feature for some time to track three subjects I’m interested in: 
UFOs, Annette Funicello and Sally Field. I’ve been interested in UFOs since the 
early 1950s, a fan of Annette since the Mickey Mouse Club Days and a fan of Field 
since her first TV appearance as Gidget. So now you know three of my not-very-
secret “secrets.”  

Google explains its alerts this way at http://www.google.com/alerts:  “Google Alerts 
are email updates of the latest relevant Google results (web, news, etc.) based on 
your choice of query or topic.”  

“Enter the topic you wish to monitor, then click preview to see the type of results 
you’ll receive. Some handy uses of Google Alerts include:  

• monitoring a developing news story 
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• keeping current on a competitor or industry 

• getting the latest on a celebrity or event 

• keeping tabs on your favorite sports teams.” 

When you create an alert, you’ll be asked to choose the topic for it, the type of  infor-
mation you want (everything, news, blogs, videos, discussions); how often you want 
alerts (as-it-happens, once a day, once a week); volume (only the best results, all re-
sults); and your email address so you can get the alerts. The fault choices are every-
thing, once a day and only the best results. Consider starting with the defaults and 
then tweaking them if the results you get aren’t what you expected.   

You might also have to tweak your selected topic. My search for Annette is “Annette 
Funicello” (in the quotes). That limits results to items with her full name. On the other 
hand, my Sally Field search is just that (no quotes around the name), so I get every-
thing with Sally and Field, which results in a few unexpected results. My UFO search 
results in news about unidentified flying objects, my intent, and the musical group 
UFO. 

I haven’t set up searches for computer-related items because I get several electronic 
newsletters that keep me informed about most of the technical subjects I’m inter-
ested in, but it’s easy to establish queries for any subject you’re interested in. For in-
stance, you could use “Linux, Ubuntu,” Microsoft, “Steve Jobs,” “Bill Gates.”   

Or you could try your own name or the name of your business if you wanted to know 
what people are saying about you or your business.  

And if you’re a sports fan, you might want to track everything said about your favorite 
team(s). You’d need to set up a separate alert for each team name. 

The site lets you set up an alert and then shows sample results for it. Just for kicks, I 
tried my first and last name (in quotes) and got references to my Facebook page, an 
obituary for a John Weigle of Augusta, Ga. (I still get spam about real estate deals in 
Augusta), and the Weigle Music Ministries, which I had never heard of.  

A search for CIPCUG showed only the CIPCUG Web site.  

Not surprisingly, a search for “Los Angeles Dodgers” resulted in more hits than any 
of my other test searches. Topics that get lots of news coverage, such as the Dodg-
ers, are obviously going to have more results than people or topics that are seldom 
in the news.   
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All the results have live links to whatever the alert finds. 

The alerts tool isn’t for everyone, but it’s useful if you have any interests you want 
to track regularly.    

 Freebies! 

By Dave Bilcik, Program Committee, Southern Tier Personal Computing Club, NY 

August 2011 issue, Rare Bits 

www.stpcc.org 

Dlbilcik (at) yahoo.com 

Summer is still here and still hot. Thunderstorms and chances of heat waves are all 
a part of August's end-game. It gets people to accept autumn more easily.  

In last month’s Freebie article I told you of DVD Flick and DVD Styler, two free 
pieces of software that will allow you to take your finished movie clips and embed 
them into a DVD that is playable for everyone. What if your clips aren’t finished? 
We have some help for you here as well... think free video editors. This software 
will allow you to tweak, edit and clip your digital movies so that even Spielberg 
might get a twinge of jealousy. If not high art, at least edit out the part where you 
caught Uncle Bob scratching his behind at the family reunion (no one needs to see 
that). A good Samaritan (Yogesh Mankani)  posted, as part of his blog (at http://
bit.ly/cjHfMR), a list of 18 different free software packages that you can experiment 
with. I will only deal with #1 on the list, Windows Movie Maker. 

If you have XP as your operating system, you received Windows Movie Maker with 
your Service Pack 2 (SP2) updates. If you are using Vista (may the Lord have 
mercy on your soul), download it from http://bit.ly/kXpG92 Or go to http://bit.ly/
gT4F8Z if you’re running Windows 7. The location  gives you a download link and 
tells you how to find out if Windows Movie Maker is already installed on your sys-
tem. Mr. Mankani has also kindly included a list of the top 10 free online editing 
software at http://bit.ly/bICenR, if you don’t want to install any software on your PC. 
All you need is a browser and a broadband connection to the net ,and you are 
ready to go. 
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Speaking of YouTube (subtle transition here), by starting your account today, you 
might avoid the DVD building entirely. Last month I suggested YouTube as a pos-
sible source of stock movie clips. If you post your immaculately edited movie to 
You Tube, just send your friends the web address of your video and let them 
watch it in their browser. Go to http://www.youtube.com/  to get things started. 
Even radio shows are posting to You Tube. Check out http://www.youtube.com/
user/JRense?blend=6&ob=5  to hear (see?) some alternative radio. You may not 
agree with it but what a range of topics. YouTube content goes from stupid to sub-
lime so be aware of your filtering options. YouTube is Google owned and oper-
ated. 

Non-free warning! Do you want your YouTube posted podcast/rants sounding 
crisp and clear? Invest in a good microphone for your system. Don’t depend on 
small built-in mics in your laptop or cheap gaming headphones. Blue Micro-
phones has some highly rated USB microphones that you can check out at http://
www.bluemic.com/desktop/. . They may look a little funky but it is said their sound 
starts to get close (for the money) to the studio. I might suggest the Blue Yeti. 
Google "Blue Yeti" as key words, hit the Shopping button at the top of the screen 
and go from there.  

Almost last words... the Barnes & Noble NOOKcolor at $249 is the lowest price 
tablet disguised as an E-Book reader. You can read and browse as is. When the 
warranty runs out, root your NOOK and have a full Android tablet plus a well-
regarded E-book reader. More details next month if I feel like it. 

My personal email address is dlbilcik@yahoo.com if you want to send me com-
ments, questions or cash. Please put “Freebies” somewhere on the subject line 
so I will have some idea about its contents. Tell me about your best free software 
experience or your our best bargain (...ever!) and I will pass it on.  **** 

5 RULES TO REMEMBER IN LIFE:  
 
1. Money cannot buy happiness but it’s more comfortable to cry in a Mercedes than on a bicycle.  
2. Forgive your enemy, but remember the bastard’s name.  
3. Help someone when they are in trouble and they will remember you when they're in trouble again.  
4. Many people are alive only because it’s illegal to shoot them.  
5. Alcohol does not solve any problems, but then again, neither does milk.  

Contributed by club member Glen Moore 
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 Radio Tray a minimalist Internet radio player  

By Bill Wayson, Regular Columnist, The Penguins Lair, Channel Islands PCUG, FL 

August 2011 issue, The Outer Edge 

www.cipcug.org 

bwayson (at) gmail.com  

I enjoy listening to music and am in the midst of a project to build a home music 
system that will allow me to play any music I own anywhere in the house using a 
hand-held computer as a remote control. Thus I ran across Radio Tray, a great little 
music player. If you use Linux and would like to listen to a wide variety of music 
while you work on your computer, then you should give Radio Tray a test drive. 

Linux provides you a number of excellent music players to choose from. Most of 
them suffer from one big downside: They tend to be do-it-all media players. They 
can handle music, both locally stored as well as Internet audio, and video. Some 
even support displaying still photographs. While these players have their place, 
they can slow your PC down and are overkill in some instances. Radio Tray takes 
the opposite approach. It does only one thing, and that is to play Internet radio sta-
tions. While it is playing, Radio Tray stays out of your way. It inserts an icon in your 
stem tray and is controlled through its drop-down menu.  

Radio Tray is available through the default Ubuntu repositories, but right now only 
version 0.6.1 is available there. I could not make this version work properly, so I got 
the latest version, 0.6.4, from the project website at http://radiotray.sourceforge.net, 
which I recommend you do. Download the DEB file, right-click the downloaded file, 
and install 

It through the Ubuntu Software Center. 

Once it’s installed, start Radio Tray by double-clicking the icon. On first start, you’ll 
be asked if you want Radio Tray to run in the system tray or as an application indi-
cator. I can see no difference between either choice as they both result in an icon 
in the system tray. Click the icon to raise a menu, which includes preconfigured ra-
dio stations and a preferences dialog.  The radio stations are grouped bookmark 
style by genre (Jazz, Latin, etc.). Peruse the menu, click on a station, and shortly 
the icon turns blue and you should be hearing music on your PC.  
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Adding new stations is pretty simple. lick on the icon, select Preferences, Configure 
Radios ....  If you want to add your station to a new group, create it first by clicking 
the Add Group button. Hierarchies of groups under other groups are supported. Add 
your new station by clicking the Add button. Name it whatever you want, enter the 
station URL, and select the group the station ought to appear under. 

Groups and stations can be rearranged by selecting the group or station and press-
ing the Move Group button.  

What is missing that would be really nice is some way of selecting some station 
you’ve found, such as through your Web browser, and adding it to Radio Tray either 
through 

a menu item or a select-and drag operation. 

Finding Internet radio stations is also simple. Internet radio stations are simply Inter-
net-accessible URLs that stream audio in a specific format. You point a player to a 
station URL just as you would point your browser to a Web page. Radio ray supports 
PLS (Shoutcast/Icecast), M3U, ASX, WAX and WVX playlist formats. Just search the 
Web using the phrase “internet radio stations,” and you’ll be presented with many 
hits to 

choose from. When you find a station that looks interesting, right click the station 
URL and copy the link. You can paste the URL into Radio Tray’s add a station dialog 
as 

described above. 

If you would like to manually add groups and stations to Radio Tray’s menu, or just 
see how the bookmarks are implemented, you can open the file 
<your_home>/.Local /share/radiotray/bookmarks.xml using any text editor. The file 
follows standard XML formatting with parts of the file being surrounded by opening 
and closing tags. The outermost tag is bookmarks. Below this is group, and in each 
group are the stations identified by bookmark tags. Study the file, noting the tags and 
their contents, and the structure should become clear to you. Before editing the file, 
you should first close Radio Tray to avoid conflicts with its use of the file and save a 
copy of the existing bookmarks.xml file to revert to in case you make a mistake. If 
your file gets completely corrupted, just delete it. A new file will be created the next 
time you start Radio Tray.   
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Radio Tray is a great way to save the location of Internet music, news, and such 
that you enjoy and to play them while you plug away on your PC. It does this while 
staying in the background and not presenting you with a lot of extraneous informa-
tion that you are not interested in at the moment. 

Radio Tray shows that in many situations, less is more. Enjoy discovering Internet 
radio. 

 Right Click Surprises – Windows XP 

By Warner Mach, Editor, SouthEastern Michigan Computer Organization 

August 2011 issue, SEMCO DATA BUS 

www.semco.org  

Machw48185 (at) yahoo.com 

I have recently become familiar with some handy uses of the mouse right-click that 
are worth mentioning. 

1. Right click on “Start” brings up a menu that lets you select Microsoft “explorer” 
and “search.” This can be a quick way to get at those utilities. 

2. If you want to use a program other than the default in conjunction with a file, 
then right click on the file and go to “open with.” I sometimes use this with pdf files. 
My default for pdf files is “Nitro” but it does not have a search function, so I will 
sometimes switch to “Adobe Reader” if I want to use the search. 

3. In the tray at the bottom of the screen is an icon that looks like a screen with ra-
diation coming from it. Left click tells the status of your Wi-Fi connection. Right click 
gives options of disable/status/repair. I was at a location where I appeared to be 
connected properly, but all of my browsers were unable to reach any URL. Some-
one assisted me by clicking on “repair” and I could watch the system rework my 
connection and make it better. I was dazzled. 

4. The most important time-saver of all: If you are playing solitaire and you reach 
the point where you have won the game and it is just a matter of moving all the 
cards to the top row, then right-click on one of the cards in the bottom row and the 
system will do the remaining work for you.  *** 
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Ask Mr. Modem! – September 2011  
www.MrModem.com  
 
Save Image with iPad 
 
Q. When I'm visiting Web sites with my iPad, is there any way I can save an 
image? I'm trying to use my iPad more in hopes of ultimately replacing my 
computer with it. Thanks, Mr. M. 
 
A. You're in good company: Many people have been dabbling a toe or two in the 
iPad pond (www.apple.com/ipad) with an eye towards replacing their desktop or 
notebook computer. While that may be appropriate for some users, not everyone 
who uses a computer will find the iPad a suitable replacement.  
 
If you primarily use your computer for email and visiting Web sites, viewing videos, 
maintaining a calendar, and other similar functions, the iPad fits the bill quite nicely. I 
have an iPad 2 and use it daily, but it will not be taking the place of my primary com-
puter. Mrs. Modem, however, did replace her PC with an iPad, so it very much de-
pends on the individual user's needs. 
 
To answer your specific question, when viewing a Web site with your iPad, if you 
find an image you would like to save, tap and continue pressing (called “tap and 
hold”) the image. You will be prompted to save the image to your iPad where it will 
then be found in the Photos app. 
 
Q. I'm not happy with Microsoft Word 2010, but I don't have an older version I 
can return to. Do I have any options or am I stuck? 
 
A. After several months using MS Office 2010, I removed it from my system and bid 
a fond farewell to my hard-earned dollars in the process. Instead, I switched to the 
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free OpenOffice (www.openoffice.org) office suite. OpenOffice has all the compo-
nent applications of Microsoft Office: Instead of Word, OpenOffice uses Writer; in-
stead of Excel, it has Calc; instead of PowerPoint, it features Impress, and instead 
of Access, it has Base. Excellent, free OpenOffice tutorials are available at  
www.tutorialsforopenoffice.org. 
 
 
Q. I am using Windows 7 and Vista, and I would like to know where the Scan 
Disk and the Defragment options are? Can you help, Mr. M? 
 
A. Click Start > Computer, then right-click the drive you want to check and select 
Properties. Click the Tools tab, then the Check Now button under Error Checking, 
which is the new name for Scan Disk. That will bring up the Check Disk window 
where you can then select whatever options you prefer, and run it.  
 
Q. I am looking for a program that I can use to zip and unzip files. I installed a 
free version of something that I can use to unzip files, but I need a program 
to zip them. Do you have any suggestions? I'm using Windows 7. 
 
A. Windows itself can zip and unzip (compress and uncompress) files, so you really 
don't need any third-party software. There are a couple of ways to unzip or zip a file 
or folder: 
 
The first and quickest way is to double-click the zipped file. You can then browse its 
contents or extract it and drag it to your Desktop. 
 
A second way to unzip a file or folder in Windows 7 is with the Unzip Wizard. To do 
this, right-click the zipped file and select Extract All. Then go to the location where 
you want to save the unzipped file by clicking Browse. Click Extract to unzip the 
file. 
 
To zip or compress, right-click the file or folder, select Send To > Compressed 
(Zipped) Folder. A zipped file will be created in the same location, with the same 
name as the original file or folder, but with a .ZIP file extension. 
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Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month  
 
Graveyard of the Pacific 
The coastline along the Pacific side of Vancouver Island is known as some of the 
deadliest in the world for ships. While it sounds a bit on the morbid side, this site is 
actually a lot of fun. You’ll find an interactive time line, a section dedicated to real-
life tales of courage in the face of tragedy, and an online newspaper called the 
Shipwreck Times. 
www.pacificshipwrecks.ca/english 
 
Ingenious 
An educational site that combines images and viewpoints to create insights into 
science and culture. It features thought-provoking connections between people, in-
novations and ideas. Drawing on the resources of the UK's National Museum of 
Science and Industry, the site contains more than 30,000 images. 
www.ingenious.org.uk 
 
NationMaster 
If you like numbers, you will enjoy this site which hosts statistics from the CIA's 
World Factbook (http://tinyurl.com/2h2e3k), the United Nations, and OECD 
(Organization for Economic Cooperation and Development). Enter a topic in the 
text box at the top of the page and click Search to view a list of statistics and ency-
clopedia entries. The default font is fairly small, so with most browsers, press CTRL 
and the + sign to increase font size, or View > Zoom.  
www.nationmaster.com 
 
“Mr. Modem's Top 50 Computing Tips,”a brand new five-ebook series, is just 
a download away on amazon.com! Each volume (only $2.99!) features 50 of 
Mr. M.'s greatest computing tips, all easy to understand, all written in Mr. Mo-
dem's warm, fuzzy and occasionally entertaining style. 

Three old guys are out walking 
> First one says, 'Windy, isn't it?' 
> Second one says, 'No, it's Thursday! 

> Third one says, 'So am I.. Let's go get a beer..' 
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DO YOU HAVE A QUESTION FOR OUR TECH GUYS, BILL BELCHER & ELL FULMER? 

Fill Out the Form Below & Bring it to the Meeting 

 

Name: ______________________________________________________________________________________________ 

 

Cptr Operating System      Windows 98   ___  Windows XP   ___  Windows Vista  ____ Windows 7 ______ Mac___ Other____ 

 

Question:_________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

 



 

333 East Foothill Blvd. 
Glendora, CA 91741  
Telephone: (626) 914-8235 

All opinions herein are those of the individual authors only, and do not necessarily reflect the opinion of the GSCC. The GSCC does 
not endorse, rate or otherwise officially comment on either products, services or vendors. Readers are cautioned to rely on the opin-
ions presented at their own risk and discretion.  

The GSCC, its editorial staff, and its contributors assume no liability for any damage arising out of the reliance upon any published 
article. 

Articles are compiled without verification of accuracy or applicability of accuracy or applicability of any article. 

We’re On The Web  
Webmaster:  
Ell Fullmer 

www.gscclub.org 
Email:  

gscc(at)gscclub.org 

Elected Officers 

Committees & Chairpersons 

Have a New  

Email Address?  

Please Notify Membership 
Chair: Jeannine Foote  

jeanninefoote(at)
yahoo.com 

Thank you to the following mem-
bers for help in this   

 month’s Newsletter: 

 Glen Moore 

  

  

 

Program Director            Jim Glass  jglass1001(at)aol.com 

Asset Management       Glen Moore mooretours(at)earthlink.net 

Membership  Chair      Jeannine Foote  jeanninefoote(at)yahoo.com 

Public Relations        Donna Hinman amegachi(at)gmail.com 

Nominations                

Programs Chair            Jim Glass jglass1001(at)aol.com 

Webmaster                     Ell Fullmer pakratt(at)gmail.com 

Education                       Bill Belcher billbelcher(at)gmail.com 

Newsletter Editor     Dan Leddy ranchitoave(at)yahoo.com 

Set-Up Chair                   Bill Hart Bobbibill(at)peoplepc.com 

Please submit Newsletter Arti-
cles by the last Friday of the 

Month.  

Type GSCC in Subject Line. 

Email to Dan Leddy 

ranchitoave(at)yahoo.com 

President                Annemarie Hunt ajhunt1447(at)aol.com 

Vice President Connie Lang connielang(at)verizon.net 

Secretary Ruthann Mayrose Ruthannmeister(at)gmail.com 

Treasurer                Rose Marie Diem catscobwebs(a)charter.net 

Tech Advisor  Ell Fullmer pakratt(at)gmail.com 

Past President—Annemarie Hunt Ajhunt1447(at)aol.com 


